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INTRODUCTION TO ARCMAP

ArcMap is where you create maps and access most of the ArcGIS functionality. 

You can add and edit data, query and symbolize map layers, and create map 

layouts for printing.

Starting ArcMap
You can launch ArcMap in more than one way. The most common way is to 

click on the start menu and go to “All Programs,” then the ArcGIS folder, then 

ArcMap 10. If you don’t see ArcGIS in the list of programs, don’t worry, it might 

still be intstalled on your computer. Look in c:\\Program Files for a ArcGIS folder. 

Open the ArcGIS folder, then the Desktop 10.0 folder, then the Bin folder inside  

that. Double-click on the ArcMap.exe file to start ArcMap. If it’s not there then 

ArcGIS is not installed on your computer.

If you want to create a desktop icon for ArcMap (so you don’t have to go 

through all of that again), right click on the ArcMap.exe file and choose “create 

shortcut.” Then copy and paste the shortcut to your desktop.

when ArcMap opens, it will ask if you want to open an blank map, use a 

template, or browse for an existing map document. when you are first creating 

a map, you will probably start with a blank map so click “OK.” If the default is 

to add an existing project, click on “My Templates” and then “Blank Map.”

Adding Data
Unless you open an Arcview .mxd file that someone else created, you will need 

to add data to get started. From the file menu, go to “Add data” or click on 

the “Add data” button (yellow square with large black + sign) on the Standard 

toolbar. Navigate to the folder where you have your map layers. with ArcGIS

10, you can use the “Add Data” button to access to other options: Add Basemap 

and Add Data From ArcGIS Online. From the “Add Basemep” option, you

can import Bing and Google aerial images, street and topo maps, and others. 

Through ArcGIS Online, you can import data many additional layers that 

include data (such as zip codes with 2010 population estimates). The “Add Data” 

option allows you to navigate to a folder and add your own map layers.



CATALOG wINDOW

Arccatalog is a system for managing and organizing map files. One big differ- 

ence with ArcGIS 10 is that a version of it (called “catalog window”) is integrat- 

ed into ArcMap. You can still open Arccatalog without opening ArcMap but it 

is much easier to use from inside ArcMap. To launch Arccatalog within ArcMap, 

click on the catalog window. Arccatalog will open on the far right.

You can add map layers from Arccatalog, but you can also view and add 

toolboxes, create geocoding services, edit and view metadata among other im- 

portant “housekeeping” tasks. The tree within the catalog window will include a 

number of folders that are commonly used with ArcGIS. In order to add your 

own map layers, you will need to “connect to Folder” to show ArcMap where 

those other important folders reside. To create a connection to a new folder, 

click on the “connect To Folder” icon at the top of the catalog window or right

when you view map layers within Arccatalog, you see them the way ArcGIS 

sees them. Some of the types of files used in ArcGIS, including shapefiles, 

coverages, and grids, are made up of multiple files that only together create 

a map layer. If you viewed them outside of Arccatalog (in My computer, for 

example), you would see all of the files listed with extensions such as .dbf, .shp,

click on the folder named “Folder connection” and choose “connect Folder.” 

Navigate until you find the folder with your data and click “OK.” Your folder 

should now be listed under “catalog” next to a icon. One note of caution: You 

do not need to do this repeatedly. Once you have established a connection to 

your folder, you will not need to do it again unless you change computers. If 

you create a new connection to the folder each time you use ArcGIS, your path 

options will become unmanageable. If you have one directory where you store 

all your GIS files, consider connecting to that rather than each individual folder 

inside.



.shx. within Arccatalog, you will see only a single file. This is especially helpful 

when you are moving or copying data.

View from Catalog Window View from My Computer

You can add data to ArcMap by dragging and dropping files from Arcwindow. 

The icons used to represent the data indicate the type of data. A light green icon 

with lines (broad_street_line.shp) indicates a line shapefile; a light green icon 

with three dots (highspeed_stations.shp) indicates a point shapefile; a light green  

icon with a square cut into three pieces is a polygon shapefile. An icon with a 

white square and two columns of lines (BusStop_TotalLines.dbf) is a table.

You can view and edit the metadata for any of your files. Right click on a file 

and go to “item description.” In most cases, the metadata will probably be 

empty. If you get into the habit of filling in at least a basic description about 

what the data are, who created them and when, you will make it much easier 

to keep track of and share your files. click on the “Edit” button to add or change 

the metadata.

Other Arccatalog Functions
Arccatalog also has extensive search capabilities, making it possible to locate 

files based on name, location on your computer, geographic location, and date. 

You can create new shapefiles in Arccatalog. This will be described in the section 

“creating New Shapefiles.”



You can move a toolbar by double-clicking on it to the left of the buttons 

(where there is a sort of handle at the edge). You can “dock” it by moving it 

over any of the gray areas on the screen. To add or remove a toolbar, go to the 

customize menu, then “Toolbars” or double-click on an empty gray part of the 

screen. Anything with a check mark next to it will be displayed.

You can add new buttons to existing toolbars from the “customize” option. click 

on the “commands” button to see your options. One especially helpful button 

allows you to zoom continuously. Scroll down to the category on the left called 

“pan/zoom,” then left click on the “continuous Pan and Zoom” button on the 

right and drag it to your tools toolbar (the toolbar with the outline of a hand 

and an image of a globe in the middle) and release (see image on previous 

page). You can also add new buttons and tools by importing scripts. That process 

is explained in a later section called “working with scripts.”

customizing the Interface
ArcMap is made up of many different windows and (dock-able) toolbars that 

you can resize and move around, so don’t be surprised if ArcMap looks slightly 

different each time you open it.

The window on the left that lists your map layers is the Table of contents; the 

window on the right that shows your map is the map display. You can close the 

table of contents by clicking on the “X.” To bring your table of contents back, 

go to the window menu, then Table of contents. By clicking on the tack symbol

next to the “X” you can hide the Table of contents; to bring it back, click on the 

word “table of contents” which will be running vertically on the far left. Resize

it by holding your cursor over the right edge until it changes to a two-headed 

arrow, then left-click and drag the edge to resize this window.

The map layers you add will draw in the order in which they appear in the 

Table of contents--so the layer at the top will draw on top and the layer at the 

bottom will draw on the bottom. You can change the order by left clicking on 

the layer you wish to move and dragging it to a new position. The icons at the 

top of the Table of contents allow for different views on your data--by source 

(so you can see where each file exists on your compute), by visibility (layers 

turned on will be listed first), and by selection (indicating whether any features 

are selected). You can only change the order of your layers from the first option, 

“List by Drawing Order” which is the default when you open ArcMap.



Navigating a Map
There are several tools available for zooming in and out of your map.

The fixed zoom in/fixed zoom out tools  

give you the least control but also may  

keep you from zooming in or out too much 

and losing your map. Each time you click,  

you will zoom in or out a fixed amount.

The pan tool works like the continu-  

ous zoom tool when you right click on it.

Think of the pan tool as a sticky hand you  

set down on a piece of paper. You use it  

to move your map up, down, left or right

without changing the extent (the degree to  

which you are zoomed in or out).

You can also pan by using the scroll bars  

on the right and bottom of your map. 

However, these are not the best way to  

navigate since they are really designed for  

scrolling in word document or image.

The continuous zoom tool gives you the  

greatest amount of control, but you have 

to add this by customizing your toolbar (see 

“customizing the Interface” above). click 

on the continuous zoom tool, then left click 

on your map, hold down the mouse button,  

and move your mouse away from you to  

zoom in and toward you to zoom out. If 

you right click and hold down, this becomes  

a tool for panning (moving map around 

without changing the extent).

Using the non-continuous zoom tools,  

you can click on your map to zoom in or out 

at a fixed amount or to draw a box around  

the area that you want to see in more or less  

detail. The new map will be drawn so that  

the area you drew the box around is in the 

middle of the map display.

The full extent button will zoom in or out 

so that all of your active (checked) map  

layers can be viewed. This is very helpful  

when you zoom in or out too much and  

can’t see your map layers. You can also  

zoom in to a single layer by right clicking

on the layer in the table of contents and  

choosing “zoom to layer.”

The previous extent button allow you 

to return to the extent you had before 

zooming in or out. The next extent button

allows you to jump forward an extent (after  

you have used the previous extent button).  

This is a sort of “undo” button in regard to  

navigation.



Setting Map Units, Display Units and Map Projection

One of the very first things that you should do after adding data is to set the map and display 
units. It is also a good idea to set the projection (if desired) at this stage as well. Setting these 
units will allow you to measure distances or compute areas. Display units should also be set if 
you are planning to create a map layout with a distance scale. To set the map and display units:

1. Right click on the data frame ‘Layers’ at the top of the legend and scroll down to ‘Properties.’



Identifying Attributes of Features
The points, lines, and polygons that make up vector map layers are all map 

features that have attributes stored in a table. This is part of what makes  

GIS unique, that it can connect attributes of a location to that location.

You can access this information in several different ways. Using the identify 

(“i”) tool, click on a map feature in the map display. An “identify results” 

box will display all of the information known about that feature. Notice 

the layers dropdown menu. The default in ArcMap is to display information 

only about the top-most layer. You can change this using the dropdown 

menu at the top of the identify pop-up box.

Showing Map Tips
Map tips are small text boxes that appear when you hold the cursor over a 

map feature. You can only see one attribute at a time (unlike the identify 

tool, which allows you to see all the attributes know for that map feature), 

but using map tips is much simpler and allows you to get a quick idea of the 

attributes. To turn on map tips, double click on your shapefile name in the 

table of contents and, from the Layer Properties, make the Display tab active. 

Put a check mark in the “Show Map Tips using the display expression” box. To 

change the “display expression,” use the dropdown menu just above.



Selecting Features
You can also use the select features tool to identify attributes, either by clicking 

on a particular map feature or by drawing a rectangle, polygon, cirle, line or 

using the lasso selection tool. The selected features should become highlighted 

with a blue outline. Right click on the map layer that contains the feature(s) 

that you wish to investigate and go to “open attribute table.” This table includes 

all the attributes of all the features in that layer. In order to view just the 

selected feature(s), click on the “Show Selected Features” button at the bottom 

of the table. Notice that there will be an indication of how many records out of 

the total have been selected.

You can also highlight a feature on the map by clicking on a row in the table 

(you need to click in the gray area on the far left). This way, you can find a 

specific place (such as cyprus) on your map. You can change the selection color 

from “options…” in the Selection menu. It is also possible to use different selection 

colors for each layer. Double click on a map layer, or right click and go to “prop- 

erties.” choose the selection tab and then select the last radio button, “Show 

selected features with this color.” This will only change the selection color for this 

map layer.

To unselect records (and get rid of the blue highlight), you can do one of several 

things:

1.Open the attribute table (right click on the name in the Table of contents and 

go to “Open Attribute Table”) and then click on the “clear Selected Features” 

button at the top;

2.with the attribute table open, click on the “Table Options” button on the top 

left and go to “clear Selection” ;

3. From the Selection menu in ArcMap, choose “clear Selected Features;

4.From the Table of contents, click on the “List by Selection” button to see 

which map layer has selected features, then right click on the one with selected 

features and go to “clear Selected Features.”



Managing & saving DATA

Many of the frustrations of new GIS users relate to saving files. ArcGIS works 

differently from most software, so if you do not take care in naming and saving 

your files, you will not be able to find or open your work.

Saving ArcMap Documents (.mxd)
An ArcMap document is made up of all the map layers you have added and 

all of the functions you have applied to them. It is best to only save an ArcMap 

document when you have spent a significant amount of time.

w hen you open ArcMap, you are prompted to specify whether you wish to

open an existing map document or create a new one. Most of the time when 

you are learning to use Arcview, you can create a new ArcMap document. If 

you will need to return to your work once you start symbolizing your map layers 

and designing a layout for printing, you will probably want to save an ArcMap 

document. You do this by going to the File menu and choosing save. This file will 

save all of the work you have done, including the list of data you have added 

and the changes you have made to layer properties, symbology, and the layout.

The .mxd file does NOT save all of the data you included in your map. Instead, 

it includes information about the location of those files on your computer (or 

network, or Internet) and the formatting changes you made. This means that 

you cannot move the data files you’ve included in a map document or just 

put your .mxd file on a thumb drive to open on a different computer without 

running into problems. It also means that map documents can be difficult to 

transfer from one computer to another. If you do move one of the files used in 

your map document, that layer will be shown with a ! next to it and will not

draw when you open your map document. If you click on the grayed out check

mark beside the layer name, ArcMap will bring up a dialog asking where you 

moved the file. Navigating to the file in its new location and clicking “add” will 

solve the problem.

Saving Relative Paths
Relative paths can help you avoid the red exclamation points some of the time. If 

you have all of the files belonging to a map document in a single folder, you can 

move it to a new location and still open it with relative paths. From the File 

menu, go to “Map Document.” and check the box next to “Pathnames” that 

says “Save relative pathnames to data sources.”



Saving Map Layers
In addition to saving the entire workspace with a map document, you can save 

an individual map layer (.lyr). This file will store all the formatting changes you 

have made to the layer. This is particularly helpful if you want to use the same 

layer, with the same symbology, in another map document. As with the .mxd 

file, the .lyr file only includes information about the formatting and the path to 

the original data (generally a shapefile). Moving your original data, or moving 

the .lyr file to another computer, will create problems.

Naming Files
Naming your files in a clear and consistent manner will make working with 

ArcMap much easier. You need to develop your own naming convention that 

makes sense to you. You may create multiple versions of the same shapefile that 

are only slightly different, so your naming convention should reflect those differ- 

ences (in year, projection, attributes, geographic level, etc.). For example:

Phila_tracts_2000_UTM.shp 

Phila_tracts_1990_UTM.shp 

Phila_bgroups_2000_stateplane.shp 

NYc_tracts_1990_UTM.shp 

NYc_tracts_1990_StatePlane.shp 

PA_tracts_2000_StatePlane.shp

ArcGIS can work with file names that are more than 8 characters, but really long 

names can be difficult to work with. ArcGIS can also work with files that have 

spaces in their name (such as Phila tracts.shp), but this can create problems (es- 

pecially with attribute names) so it is best to avoid by using underscores ( _ ).

creating Map Packages
ArcGIS 10 includes an option to package up your .mxd file with all the data used 

to create the map document on the model of Adobe products. This is especially 

useful for moving your files for a specific project from one computer (or location 

on a computer) to another or sharing the files with someone else. From the

File menu, go to “create a Map Package.” You must save the map document 

(.mdx) file first, then the map package.You will also need to give the map 

document a description (title, summary and other information are optional) and 

indicate where you want to save the map package. Once you have identified 

the location where the package should be saved, click the “validate” button to 

make sure all of the associated files can be found. Then click “Share” to create 

the map package. Map packages have the extension .mpk.



Saving and Storing Files
The most important thing in storing files for ArcMap is to think through a system 

BEFORE you start, so you can avoid moving files and disabling your map docu- 

ments and layers. consider creating a new directory for each new mapping 

project. Keep all map documents, map layers, and tables in that directory. Even 

though it will require more storage space, you may want to keep separate 

copies of the same map layer, such as a streets layer, in each project folder 

where you will be using it. As you work with ArcGIS, you will also be creating 

new tables and shapefiles. whenever ArcGIS is creating a new file, you will be 

given an opportunity to give it a name and specify a location with a dialogue 

box like this:

click on the folder icon to show Arcview exactly where you want the new file 

and then give the file a new name. Otherwise you will end up with files called 

“Export_Output.shp” and other unhelpful things like that. No one can help you 

if you don’t know where your files are or what you called them (trust me, this is 

about the worst problem you can have with ArcGIS).

As you create new versions of old layers, delete the old layers to keep your files 

neat. And remember, it’s best to delete files from the catalog window.



There are two types of geodatabase architectures; these are Personal geodatabases and 

Multiuser geodatabases.

1. Personal geodatabases, which are freely available to all ArcGIS users. It uses the 

Microsoft Jet Engine database  file structure /MS Access/.

• Personal geodatabases are much like file-based workspaces and hold 

databases up to 2 GB in size. o  Microsoft Access is used to work with 

attribute tables in personal geodatabases.

• It is ideal for working with smaller datasets.

• It supports single user editing.

2. Multiuser geodatabases require the use of ArcSDE and work with a variety of DBMS 

storage models (IBM  DB2, Informix, Oracle.both with and without Oracle 

Spatial.and SQL Server).

• Multiuser geodatabases are primarily used in a wide range of work o

• It uses to extremely large, continuous GIS databases.

• Many simultaneous users.

• Extremely large sizes.

Personal Geodatabase

ArcCatalog works based on file hierarchy. Folder is the top on the hierarchy. The second, 

third and forth are Geodatabase,  Feature Dataset and Feature Class respectively. 

Therefore, feature class can be stored in feature dataset, feature dataset  can store in 

geodatabase and geodatabase can store in folder.

N.B There are a possibility to do without the use of geodatabase directly in folders but we 

strongly advise you to use a  geodatabase approach.

1

To create personal Geodatabase

2

1.Right click on the selected folder

2. Click New

3.Click on Personal Geodatabase.

4.Rename the name

GeodataBase



To create feature Dataset

1. Right click on the created geodatabse

2. Click New

3. Click on Feature Dataset

4. Write the name of your feature dataset and click Next

5. Select the projection and click /select, Projected coordinate system, UTM, Others GCS and Adindan 
UTM Zone 37N and Next

6. Accept the default and click Next

7. Accept the default and click Finish. The new feature dataset will added to your table of content

4
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To Import Feature Class

1

3

2

6 7

1. Right click on the created feature dataset

2. Click Import

3. Select new and click single or multiple feature class

4. Follow the wizard

5. Click Ok

Importing single feature class Importing multiple feature class

Importing single feature class needs the output name where as the multiple feature class does not an output data name it uses 
the input data.

GeodataBase



DATA formats

ArcGIS can work with many different types of data, only some of which are de- 

scribed in this section. ArcGIS 10 can work with more different data formats than 

previous versions of ArcGIS.

Tabular data
Tabular data includes things like comma delimited or fixed width text files, 

Excel worksheets, Access files, and dbase files. This is where you store attribute 

data, which includes any information you have about a location. For example, 

you might know the types of programs offered at a recreation center or the 

total population of a zip code. In order to be mapped, tabular data generally

needs to be linked to spatial/

geographic data. Unlike 

some earlier versions (8 and  

earlier), ArcGIS 10 can work

with Excel files. w hen you add  

an Excell file to ArcMap, you  

must specify which work-  

sheet you wish to add, so try  

to remember to name your 

worksheets in Excel (no spaces  

in the name). when you add 

data, double-click on the  

name of the .xls file to see

the names of the worsheets.  

Highlight a worksheet and  

click “add.”

Adding XY Data
Some tabular data include XY coordinates. For example, data might be col- 

lected using a GPS device or a data vendor might sell the names and addresses 

of supermarkets and include XY coordinates for mapping. converting lists of 

addresses to points on a map usually involves a process called geocoding and

is explained later in this manual. You do not need to geocode if your table 

already includes XY coordinates. From the File menu, go to “Add Data” and

“Add XY Data.” From the “Display  

XY Data window,” choose the field  

that contains the X (longitude)  

and Y (latitude) coordinates. If you  

know the projection used to collect  

or create the data, click on the  

Edit button and set the projection  

(projections will be described later  

so don’t worry if this doesn’t make  

sense at this point).



.dbf - the dBASE file that stores the attribute information of features. 

when ashapefile is added as a theme to a view, this file is displayed as a 

feature table.

.sbn and .sbx - the files that store the spatial index of the features. 

These two files may not exist until you perform theme on theme selec 

tion, spatial join, or create an index on a theme’s shape field.

.pjr –  the file that stores information about the projection. This will only 

exist for shapefiles with defined projections.

The shapefile stores information about the shape of the map features, describ- 

ing them in the “shape” field of the attribute table as point, line, or polygon. It 

also stores information about the real world location of each vertex that makes 

up the map features. Using this information, Arcview can calculate area and 

perimeter for polygon features.

Geographic data
The tabular data you use in ArcGIS can be used in other programs like Excel,  

SPSS, SAS, and STATA, but the geographic data you use can only be used in GIS 

programs. Geographic data store information about location so that they can 

be represented as map layers. Geographic data can be categorized as vector or 

raster. This manual deals primarily with vector data.

Shapefiles
Shapefiles are the most common format for vector data in ArcGIS. vector data  

use points, lines, and polygons to represent map features. vector GIS is excel- 

lent for representing discrete objects, such as parcels, streets, and administrative 

boundaries. vector GIS is not as good for representing things that vary continu- 

ously over space, such as temperature and elevation.

Esri created the shapefile format in order to represent vector GIS data in a 

simpler format than their coverage format used in ArcInfo. As with other formats 

of geographic data, shapefiles link information about the location and shape

of the map features to their attributes. Other GIS programs will allow you to 

use shapefiles, but geographic files from other GIS programs must be converted 

to shapefiles before ArcGIS can read them. Shapefiles are made up of three or 

more files that need to be stored in the same directory in order for ArcGIS to 

recognize them as shapefiles. when you look at your shapefiles through ArcMap 

or Arccatalog, you will only see one file, but if you look at them directly on your 

hard drive or thumb drive, you will see multiple files with the following exten- 

sions:

.shp - the file that stores the feature geometry (point, line, or polygon)

.shx - the file that stores the index of the feature geometry

Topology
On of the biggest complaints about the shapefile format is that it does not 

contain information about topology. Topologic formats (like coverages used in 

ArcInfo) contain detailed information about the relationships among features 

in the same map layer. This allows for a variety of operations to ensure the 

integrity of lines and polygons and to carefully edit and create new geographic 

features. In creating the shapefile format, ESRI intentionally created something 

that is simpler than existing topologic formats for desktop (rather than profes- 

sional) GIS users.

Images
ArcGIS allows you to import and export many different types of images. The 

images you import may be scanned paper maps, aerial photos, or other pictures 

or photos that you “hot link” to your map features. ArcMap can import a wide



range of file types. You can also export finished maps in ArcMap in a number  

of formats: EMP, BMP, EPS, TIFF, PDF, JPEG, cGM, JPEG, PcX, and PNG.

Images are like tables in that they may contain information about a particular 

location, but they do not store location information so they cannot be mapped. 

when you add a large image to ArcMap, you will often be prompted to decide 

whether you wish to “build pyramids.” Generally you want to say “yes” because 

this will make it easier to work with the image in ArcMap.

You will also receive a

message that ArcMap  

is unable to draw the  

image as a map layer  

because it is missing  

information about 

location. So why would  

you add an image

to ArcMap in the first 

place? Because images  

like aerial photographs 

and scanned historical  

maps can be trans-  

formed into map layers 

through a process called  

georectifying.

Raster map layers
Raster data use grids made up of regular cells, or pixels, to represent spatially 

continuous data. They look like regular images, but each pixel is assigned real 

world coordinates and an attribute value (such as precipitation level or eleva-

You can view raster layers in  

ArcMap without any ad- 

ditional extensions, but you  

need the Spatial Analyst  

extension to analyze or  

create new raster layers. 

w hen raster layers have the  

same size cells, their values  

can be added, subtracted,  

multiplied, divided and

queried using map algebra (a system developed by Dana Tomlin). You can add 

raster data to ArcMap just as you do vector data, using the “add data.” Be sure 

to highlight the layer you want, then click “add” (if you double click, you will 

see the individual bands that make up your raster lay). ArcMap saves raster 

layers in its GRID format. Arccatalog recognizes GRIDs and other image formats 

(including BMP, JPEG, TIFF) as raster layers.

Geodatabases
ESRI has moved toward a new geographic data model called a geodatabase 

that used Microsoft Access files to store multiple tables, shapefiles, and raster 

images. Geodatabases are more complicated than shapefiles and a license for 

ArcEditor (not just Arcv iew) is required to edit geodatabases. Shapefiles are  

generally sufficient for individual projects, but geodatabases are more appropri- 

ate for work environments where multiple people are accessing information or 

when advanced editing is required.

tion), so the data can be mapped. The user defines the cell size, allowing for very 

fine or course raster surfaces. Even when the cell size is very small, you can see 

the individual square cells when you zoom in.



Creating new g eographic f iles

Editing shapefiles

Editing shapefiles is tricky—and a bit dangerous—territory. If possible, use the

geoprocessing tools such as clip, union, intersect, and dissolve to make changes to 

your shapefiles rather than using the editing tools described below. The directions 

provided here are very minimal. If you need to do much editing of shapefiles, 

you should seek out additional resources (such as the Esri virtual campus course 

on digitizing).

Deleting and Modifying Features
In order to make changes to a shapefile, you must start an edit session. From 

the Editor toolbar, choose “start editing.” If you have multiple shapefiles in your

map document  

that are from 

different sub- 

directories on  

your computer,  

you will need 

to specify which

directory will be  

part of the edit 

session (you can  

only edit the files  

in a single folder  

at one time).

A new window  

will appear on 

the far right

side of your screen, next to the catalog window if you have that open. To save 

edits, from the Editor menu on the Editor toolbar, choose “Stop Editing” and

say “yes” to saving edits. Notice that 

you do not have a “save as” option.  

You may want to make a backup  

of your original data before editing.

click on the name of your shapefile in 

the top section so that options appear 

under “construction Tools.” You can  

use any of these to add features to  

your shapefile. You can “snap” a new  

feature to an existing feature to avoid 

small “sliver” polygons between two  

map features. The snapping options  

are available in the Edit menu.

You can also edit existing features by clicking on the edit tool (looks like the 

head of a black arrow) and double-clicking on a feature. Notice that green 

squares appear at ever vertex of your feature. You can add or delete features

using the “Edit vertices” toolbar 

that appeared when you double- 

clicked on the map feature. You  

can also split a polygon in half. To  

do this, highlight the feature you  

wish to split (this involves a single  

click, not a double-click; you want  

to see the blue highlight but not

all the vertices). click on the “cut Polygons Tool.” Draw a line across the polygon 

and double click to complete the spit.



Dig itizing

Most of the time you will use shapefiles that someone else created. Using existing 

shapefiles saves time and generally results in more accurate map layers. But

if you need a line or polygon file that doesn’t exist—such as a boundary for 

your study area—you will need to create it yourself. Digitizing is the process 

of drawing or tracing map features to create a new geographic file. Before 

on-screen digitizing was available, this process involved tracing a paper map

on a digitizing tablet and then assigning real world coordinates to certain parts 

(like georectifying). But Arcview has on-screen digitizing tools that allow you to 

create new shapefiles without additional hardware or software.

Creating New Shapefiles
You’ll need to create a new empty shapefile to get started. You can make

a copy of an existing shape-  

file, delete all of its features  

(start editing, highlight all the 

features, and click the “Delete”

key on your keyboard) and then  

create new features. Alterna- 

tively, you can create a brand  

new shapefile. To create a new  

shapefile, right click in a folder  

within the catalog window and 

go to “New” and “Shapefile.”  

Decide what kind of shapefile  

you need (point, line, polygon), 

give it a name, and set the pro-  

jection if you know what you’ll 

be using.

Next, open ArcMap and add your new shapefile, along with other map layers 

that may help you draw your new features. Start an edit session: from the Editor

menu in the Editor toolbar, choose 

“Start Edit Session,” and indicate  

which directory contains the  

shapefile (shell) you just created. 

click on your new shapefile name  

in the “create Features” window 

that should appear on the far  

right, next to the catalog window, 

to bring up the construction tools. 

create one or more features  

(remember, the snap options in 

the Editor menu will allow you

to make much neater shapefiles) 

and then go to “Stop Editing” and  

say “Yes” to saving changes. Open  

the attribute table for your new

shapefile. Notice that there are FID and Shape fields but nothing else. You can 

add attributes

manually, 

by creating 

new fields  

and filling in 

the values or  

by joining an  

existing at-  

tribute table  

to the new 

shapefile.



Merging Features
In order to dissolve the boundaries between two or more polygon features, 

you must start an edit session. Using the edit tool and the shift key, click on the 

features you wish to merge (they should become highlighted). You can also

select map features based on their attributes by opening the attribute table and 

selecting the corresponding records. From the Editor menu on the Editor toolbar, 

select “Merge.” By merging the two features, you are also merging the attri- 

butes. ArcGIS will ask you to choose the feature with with other features should 

be merged; the attributes from this feature will be maintained. To save edits, 

from the Editor menu on the Editor toolbar, choose “Stop Editing” and say “yes” 

to saving edits.

Updating Area, Length, and Perimeter
Keep in mind also that editing shapefiles can change attribute values that you 

may need to update. Follow the directions in the section of this guide entitled 

“calculating Area.”

Geoprocessing

the selected features.

There are a number of different functions you can perform on map layers, either 

based on location or attribute value, that result in new map layers. In ArcGIS 10, 

these are once again called “geoprocessing” functions. You must define the pro- 

jection for map layers before using any of these functions. If you have selected

a subset of features within a map layer, the functions will only be performed on

Dissolve
The dissolve operation allows you to collapse  

the boundaries between polygons if they share 

the same value on a particular attribute. For 

example, you could create a neighborhood 

map layer by assigning each census tract to a 

neighborhood and then dissolving the bound-  

aries. From the Geoprocessing menu, go to 

“Dissolve” to bring up the Dissolve wizard. On 

the first screen, identify the map layer whose 

features you wish to dissolve under “input  

features.” If the layer is already added to

ArcMap, you can use the dropdown menu. Otherwise you will need to click on 

the folder icon to locate the may layer. ArcMap will give the new shapefile that 

will be created a default name (adding “_Dissolve” to the input layer name). If 

you want to rename this or change the location, click on the folder to the right 

of “input feature class.” Next, choose the “Dissolve Field”--the column from 

that layer’s attribute table that contains the information you wish to use for the 

dissolve. This must be an attribute for which multiple map features (polygons)



have the exact same value (numbers or text). ArcGIS will create a new shape- 

file that combines all of the map features (census tracts) into a single polygon 

(neighborhood). You can aggregate data for the original geographic units to the 

new (dissolved) geographic units using the optional “Statistics Field.”

them all at once). A new layer will be created containing all of the features of all 

of the shapefiles. Specify the location and name for this new shapefile and click 

“OK.” After a few seconds, you will see “Merge... Merge...Merge” appear at the 

bottom right of your screen. when ArcGIS has completed this process, the new 

shapefile will appear at the top of the top of the Table of contents.

Merge
Appending allows you to incorporate two or more non-overlapping layers 

into a single map layer without changing their map features. You can append

point, line, and polygon layers. Appending can save you time when it comes to 

symbolizing features and lead to more consistent symbology. For example, you  

can merge census tract files from several counties so that when you display the 

percent of homeowners, you don’t have to repeat the process of classifying your 

data for each county.

From ArcToolbox, you can find “Append” under “Data Management Tools” and 

“General.” Under “input features,” list all the map layers you wish to merge. You 

can use the dropdown menu if you have added the map layers to ArcMap, but 

you will need to add them one at a time (if you add them directly from your 

computer, not from ArcMap, you can highlight multiple shapefiles and add



Clip
clipping allows you to turn one shapefile into a cookie-cutter in order to cut 

out part of a larger shapefile. For example, you might need to create a map 

layer of streets for the area within a single police district but your street cen- 

terline file covers the entire city. Using a street file that is clipped by the police 

district boundaries will allow you to work with a smaller and more manageable 

file that looks neater. From the Geoprocessing menu, go to “clip.” On the next 

screen, you need to identify an input feature (the layer to be clipped) and the 

clip features (cookie cutter). The default name for the new shapefile will be the

input feature name plus “_clip.” If you want to change this or the location of the 

new file, click on the folder to the right. You can leave “cluster Tolerance’ at 0. 

changing it will allow slightly mismatched map layers to be considered “coinci- 

dent.”

Intersect
Intersect allows you to fuse two overlapping layers together to create a new 

shapefile that includes the attributes of both layers for the area in which the 

layers overlap. In effect, this combines the union (described below) and clip 

operations. You can intersect two polygon layers or a line and polygon layer. 

From the Geoprocessing menu, select “Intersect.” On the next screen, select the 

input features. The default name for the new shapefile will be the first input 

feature name plus “_Intersect.” If you want to change this or the location of the 

new file, click on the folder to the right. If you intersect a line and polygon layers, 

the resulting shapefile will contain “polylines” that act like lines. If you intersect 

polygon layers, the resulting shapefile will contain polygons. Length, perimeter, 

and area values will be inaccurate after you perform an intersection, so if you 

need these, be sure to recalculate them.

Union
Union is similar to intersection in that it fuses the boundaries of two layers 

together, but rather than clipping the resulting shapefile to include only the area 

covered by both, it creates a new shapefile that covers the combined extent of 

the layers. From the Geoprocessing menu, choose “Union.” On the next screen, 

select the input features. The default name for the new shapefile will be the first 

input feature name plus “_Union.” If you want to change this or the location of 

the new file, click on the folder to the right.

+ =



Buffers

Buffers allow you to visualize zones around map features. If you are interested 

in seeing which schools fall within 500 feet of class 1 (highways), you can create a 

500 foot buffer around class 1 streets. For analysis purposes, queries by location 

may be more helpful because they will allow you to actually select the schools 

within 500 feet of class 1 roads. But you may want to create buffers, as well, so 

that you can visualize this relationship.

The easiest way to create buffers is using the Buffer wizard. You’ll need to add 

this to one of your toolbars (from the view menu, go to Toolbards, then cus- 

tomize, then click on the “commands” tab, then click on the “Tools” category. 

click on “Buffer wizard” and drag it to one of your toolbars. click on the new 

tool to launch the wizard. Select the map layer you wish to buffer using the first 

dropdown menu. You

can choose to buffer all  

features or just the cur-  

rently selected features  

in a map layer. click 

“Next.” Determine the 

distance for your buffer  

(adjust the distance 

units at the bottom). If  

you want to have more 

than one buffer, choose  

“As multiple buffer  

rings.” click “Next.”

On the final screen of the Buffer wizard, choose whether you want to dissolve 

the boundaries between buffers--since in many cases, your buffers will overlap. 

In the next section, you will choose “only outside polygon(s)” in most cases. Your 

final choice is whether to make your buffers graphics, which are temporary, or as 

a new shapefile, which is permanent. If you are just playing around to figure out 

what size your buffer should be, use graphics. If you plan to use the buffers for 

any analysis, be sure to save it as a shapefile. If you choose to make a shapefile,  

click on the folder icon, indicate where the shapefile should be stored, and give it 

a name. Then click “Finish.”



Simplifying a feature (Generalize)



Smoothing a feature (Smooth)



Spatial analyst Tools helps to work with raster data. It has a number of functionalities.

1. Extract by mask function /Clip Raster data/

1

2
4

3 5
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1. Click the plus sign in front of the Spatial Analyst Tools

2. Click the plus sign in front of Extraction

3. Double click on extract by mask function

4. Select raster input map

5. Select raster or feature mask data

6. Change the name of the folder and 

file name of your output data
7. Click ok
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Spatial Analyst Tools

2. Surface Analysis

Surface analysis helps to analyze /to extract/ data from DEM /Digital Elevation 
Model. Using surface analysis you can create contour, slope, hillshed, aspect etc. 
for this training we will focus on the contour and slope calculation.

1. Creating Contour
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3
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2.       Creating Slope

4

5

7

1. Click the plus sign in front of the Spatial Analyst Tools

2. Click the plus sign in front of Surface

3. Double click on extract by Contour function

4. Select raster input file

5. Change the name of the folder 

and file name of your output data
6. Determine the contour interval

6 7. Click ok

1. Click the plus sign in front of the Spatial Analyst Tools

2. Click the plus sign in front of Surface

3. Double click on extract by Slope function

4. Select raster input file

5. Select PERCENT_RISE option

6. Change the name of the folder and 

file name of your output data

6 7. Click ok



Mosaic is the process of joining two or more raster images together. It is very 
important for watershed delineation from topographic maps using contours and 
drainage networks because our watershed could be found in more than one 
topographic maps. In this case, we should mosaic the topographic maps. In this 
training, we will see how to mosaic two or more topographic maps for watershed 
delineation purposes.
Please follow the following steps in order to mosaic two or more topomaps 
together;

• Prepare a topomap cutter (i.e create a polygon shape file in ArcCatalog),

• Open ArcMap,

• Add both the created topomap cutter and two adjacent topomaps,

• Draw a topomap cutter based on one topo map (to draw follow the border of 

the topomap)

•Extract new topmap based on the prepared cutter

•Mosaic the two topomaps using 

mosaicing tools in ArcMap;

1. Open ArcToolbox,

2.Click on Data Management tool,

3.Click on raster,

4.Click on Mosaic to New Raster,

5. Add the two topomaps that you 

prepare for mosaicing, in Input 

Raster dialog box
6.Provide the required folder name

7. Write 3 on the number of bunds 

dialog box
8.Click on OK.
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Mosaic two or more topomaps



Querying & measuring

Querying by attribute

with GIS, you can identify a subset of map features based on their attributes or 

their location. You may use queries as an intermediary step, as part of getting to 

know your data, to create new values, or to answer your research questions.

Select by Attribute
To start a query, from the Selection menu go to “Select by Attributes.” Your first 

choice is what layer in your map you wish to query (attribute queries are limited 

to a single layer). In the Method drop down menu, you need to decide whether 

you are building on a previous query or starting fresh.

From here, the query dialog is similar to the Field calculator. Build an expression 

using the field names and functions, connecting statements with “AND” or “OR” 

as necessary. If you want help working through these steps, click on the Query 

wizard button. click “verify” to make sure ArcMap likes your expression. You 

can import (Load) and save expressions (using the buttons OR using ctrl + c and 

ctrl + v  with a word processing file). Note that if the values you input are text, 

rather than numbers, you need to put single quotes around them (for example, 

‘BROAD’). when you click “Apply,” the map features that satisfy your query will 

be highlighted with a bright blue outline.

To review the selected records, right click on the map layer and go to “Open At- 

tribute Table.” click on the Select button at the bottom to view only the selected

records. You can calculate values on an existing or new field for only the selected 

records. You can also look at summary statistics for only the selected records

by right clicking on a column name and going to “Statistics.” By looking at the 

statistics for the length field on the selected southbound one-way streets, we can 

see that there are 3,462,432 feet (655.7 miles) of southbound one-way streets in 

Philadelphia.

To see all of the selected records, from the Selection menu, go to “Zoom to 

Selected Records.” You can create a new shapefile that only includes your 

selected map features by

right clicking on its name  

in the Table of contents,

going to “Data” and “Export 

Data.” choose the radio  

button regarding coordinate 

systems (you’ll probably  

want the default). Make 

sure you have “Selected  

Records” chosen in the  

Export drop down menu. To 

un-select all records, from  

the Selection menu choose  

“clear Selected Features.”  

You can perform an ad-  

ditional query (adding, 

removing, or selecting from  

this selected group) or close  

the query dialog.



Querying by LOCATION

The ability to query based on the location of map features is something unique 

to GIS, and combining attribute and location queries really takes advantage of 

GIS functionality.

Select by Location
To select features in a map  

layer based on their location,  

from the Selection menu go  

to “Select by Location.” Your  

first choice is the selection  

method. Are you starting 

from scratch or querying

a subset of map features  

already selected? In the next  

box, put a check mark next  

to the map layer(s) whose 

features you wish to select.  

The drop down menu then  

provides various relationships  

between the features in that 

layer and the “source” layer,  

identified in the next drop 

down menu.

For distance-based queries, you will be able to select your units as long as the 

map units have been specified in the Data Frame properties. This query shows 

which charter schools are within ¼ mile (1320 feet) of public schools.

Combining Attribute and Location Queries
The “Select by Attribute” and “Select by Location” dialogs do not allow you to 

mix the type of query. But by performing one type of query first and then con- 

ducting a subsequent query on the selected records, you can perform attribute 

and location queries on the same map layer. For example, you may be interest- 

ed in which schools are located within 500 feet of class 1 (highways) streets. Using 

the “Select by Attribute” dialog, identify all the code 1 streets first, then select the 

schools “within a distance” of 500 feet of the selected streets. Under “Selection 

Method,” be sure to choose “select from the currently selected features in” when 

you perform the second (location) query; otherwise you will loose the results form 

your attribute query. There is no limit to how many queries you can combine.



Using Query Results
The turquoise highlight feature is meant to help you visualize relationships, but it 

is not meant for final maps. Once you have identified a subset of records, create 

a new variable and symbolize it properly using the symbology tab. For example, 

if you want to create a map showing the schools that are located within 500 

feet of highways, complete the query and then use the query results to create

a dummy variable indicating which schools meet the query definition. Do this 

by opening the attribute table for the schools. create a new variable called 

“class1500” (for 500 feet within class 1 street) that is formatted as an integer. 

Right click on the new column, then go to “Field calculator.” Set class1500 = 1. 

Only the highlighted records will be assigned this value. Assign the other records

= 0 by going to “switch selection” from the “option” button on the bottom of the 

table.

Measuring distances

Using the Measure Tool
The measure tool (on the Tools tooldbar; it looks like a ruler) allows you to draw 

a line, or a series of connected lines, to roughly measure the Euclidean (as the 

crow flies) distance between points.

click on it and then click on your map at the starting point. Move your cursor to 

your end point, or next point, repeating until you are done. Double click to finish. 

The measure tool will use the map units particular to that map layers projection 

or the display units you specified in the Data Frame Properties. You can change 

this from the Data Frame Properties (right click on the name of the Data 

Frame, go to Properties, and the General tab) or in the Measure pop-up box.

The black triangle pointing  

down includes various  

distance units to choose  

from.

You can also calculate Area  

using the tool shaped like

a polygon. Simply draw a 

polygon and double click to 

finish.



Measuring with Attribute Data
If you need more accurate measures of distance than you can get using the 

measure tool, you can use the values in the perimeter (polygons) and length 

(line) fields of the shapefile attribute tables. Select the features of interest, then

right click on the perimeter or length

field and go to “Summary.” The “sum”  

field will indicate the total distance. For 

example, if you need to know the total  

length of Broad and Market Streets, go 

to “Select by Attributes” and select all  

line segments in the street centerline file  

called “BROAD” or “MARKET.” Then  

open the attribute table associated with  

the street centerline file, right click on 

the “length” column heading, and go to 

“Summary.” The “sum” should indicate  

how long Broad and Market Streets are.

Buffers

Buffers allow you to visualize zones around map features. If you are interested 

in seeing which schools fall within 500 feet of class 1 (highways), you can create a 

500 foot buffer around class 1 streets. For analysis purposes, queries by location 

may be more helpful because they will allow you to actually select the schools 

within 500 feet of class 1 roads. But you may want to create buffers, as well, so 

that you can visualize this relationship.

The easiest way to create buffers is using the Buffer wizard. You’ll need to add 

this to one of your toolbars (from the view menu, go to Toolbards, then cus- 

tomize, then click on the “commands” tab, then click on the “Tools” category. 

click on “Buffer wizard” and drag it to one of your toolbars. click on the new 

tool to launch the wizard. Select the map layer you wish to buffer using the first 

dropdown menu. You

can choose to buffer all  

features or just the cur-  

rently selected features  

in a map layer. click 

“Next.” Determine the 

distance for your buffer  

(adjust the distance 

units at the bottom). If  

you want to have more 

than one buffer, choose  

“As multiple buffer  

rings.” click “Next.”



Digitizing using the Merge Tool
The tools in ArcMap for dissolving boundaries between features provide another 

approach to digitizing. This may give you less control over the shape of new map 

features, but it provides an easier way of creating new shapefiles that line up 

with existing shapefiles. In order to create shapefiles using the dissolve tools, you 

need to have a shapefile that can serve as building blocks for your new file. For 

example, you may want to create a map of health districts. If the districts are 

based on census tracts, you can use a shapefile of census tracts to build your new 

district file. A census block file may prove the most helpful since its boundaries 

correspond to streets. It is a good idea to make a copy of the shapefile you will 

use so you don’t mess up the original.

Using the “Select Features” tool, highlight the blocks that make up the new 

area for which you are creating a shapefile. You can select multiple features by  

holding down the shift key. You can also draw a box around the area contain-

ing the individual features (this is faster). To dissolve the boundaries between the 

blocks, from the Editor menu go to “Start Editing,” then choose “Merge.” Stop 

editing and save edits to finish. If your new shapefile only needs to include this 

single map feature, you can right click on the new feature you just created, go 

to “Data” and “Export Data.” Be sure that the Export drop down menu indi- 

cates that only selected features will be included. Alternatively, you may need to 

repeat the process of dissolving boundaries to create all of the map features.

creating a Mask
Masks are shapefiles  

that allow you to cover 

up areas that you  

don’t want to show 

without clipping them. 

clipping data only 

works with shapefiles,  

not with grids/raster 

data, so masks are  

especially useful when  

you are working with

raster data. To do this, add a shapefile of the area you want to be able to see— 

for example, a neighborhood or city—and an empty polygon shapefile. Start 

editing the new shapefile and create a rectangle around your other shapefile, 

large enough to cover up any area you don’t want to see. Stop editing and save

changes. Use the “Union”  

tool in the Geoprocessing 

menu to fuse these two  

shapefiles together. Then  

start editing the resulting 

fused shapefile. Highlight  

the inside of the new  

shapefile (the area you  

want to be able to see),  

open the attribute table  

and click the “delete” 

key. Save your changes.



Working with projections

Projections are probably the trickiest part of working with spatial data. The 

stakes are high because if data are not projected properly, you might not even 

get your map layers to draw together. Don’t be afraid to ask someone for help 

or to start over (download the original data again). Hopefully there is some 

consulation in knowing that most people have a hard time with this stuff.

Projections manage the distortion that is inevitable when a spherical (okay, 

ellipsoid) earth is viewed as a flat map. All projection systems distort geography 

in some way—either by distorting area, shape, distance, direction, or scale. There 

are dozens of different projection systems in use because different systems work 

best in different parts of the world and, even within the same parts of the world, 

GIS users have different priorities and needs. when you are looking at a relative- 

ly small area, such as a single city, there is relatively little distortion because the 

curve of the earth is slight. But knowing and setting projections properly is also 

important for getting your may layers to draw together, distance units to make 

sense, and some of Arcview’s tools to work. So in the end, it’s practical to take 

care in projecting your data.

Recognizing the coordinate System
Map layers can be drawn according to a geographic coordinate system (unpro- 

jected) or projected coordinate system. Geographic coordinate systems indicate 

location using longitude and latitude based on a sphere (or spheroid) while 

projected coordinate systems use X and Y based on a plane. As long as computer 

screens and printed maps are flat, projected coordinate systems will be more 

appropriate for working with GIS data. You may not always know the coordi-

nate system being used, particularly if you inherit data or download it from the 

Internet. If you are lucky, the map layer will include a .proj file which contains 

information about the coordinate system, or the metadata will provide some 

explanation. You can look at the information in the .prj file—the detailed spatial 

reference information—by clicking on the “general” tab of the layer properties 

from ArcMap. Alternatively, you

can click on the “fields” tab of the  

layer properties from Arccatalog, 

click inside the “shape” field and  

click on the “…” button to the right  

of “Spatial Reference.” You can



working with “Unprojected” Layers

In most cases, you will want to convert unprojected map layers—those with a 

geographic coordinate system—to projected map layers. Any of the files you 

download from the US census website or Esri TIGER files site will be in this “un- 

projected” format. There are two steps involved in this process. First, you must 

create a .proj file by “defining” the map layer as unprojected; then you can 

“project” the map layer using the projection of your choice. You can access the 

tools for doing this by clicking on the ArcToolbox icon inside ArcMap. click on 

“data management tools” and then “projections and transformations.”

Defining projections
Defining a projection registers the current coordinate system of your map layer. 

It involves reporting to Arcview the nature of the data that you have, not 

changing that data. To “define” the coordinate system for your unprojected map 

layer, click on the “Define Projection” wizard. First you will be asked to choose

a data layer. If you added the relevant map layer to ArcMap, you will be able 

to find it in the dropdown menu. Otherwise you will need to click on the folder 

icon to locate your map layer. Then you can choose the coordinate system using 

the button. click the “select” button on the Spatial Reference Properties. In most 

cases, you can choose “Geographic coordinate Systems,” “North America,” and 

“NAD 1983 Datum,” then click “okay.” You should not notice a difference in how 

the map layer is drawn as a result of defining the coordinate system. But as a 

result of defining it, there is now a .proj file associated with your map layer and 

you can look at the detailed spatial reference information. Before you define a 

layer as unprojected, Arcview will refer to it as “assumed geographic.”



working with Projected Map Layers
Sometimes the map layers you acquire will already be projected but won’t carry 

a .proj file so you won’t know the projection. The best thing to do in this situa- 

tion is to look at the original source for information about the projection system, 

either on a website, in metadata that came with the file, or by calling the person 

who created the data. If these approaches all fail to reveal the projection, map 

the data in order to guess the projection. You may recognize the projection by 

the units showing in the gray bar below the map. If they are not in longitude 

and latitude, they are probably projected. As you work with a particular projec- 

tion system, you will come to recognize the map units and range of coordinate 

values. For example, State Plane coordinates for Philadelphia are generally in 

feet and look like 2691607.78, 246268.98. UTM coordinates will be in meters and 

look like 486850.72, 4430095.19.

Projecting shapefiles
Projecting a shapefile changes the projection system. You can only do this if you 

have defined (registered) the existing projection. You can project map layers 

that are unprojected (geographic coordinate system) or change the projection 

on layers that already have a projected coordinate system. In order to project 

the map layer, click on the “Project” wizard. If you are projecting a shapefile, use 

the “Project” wizard listed under “Features.” If you are projecting a raster image, 

use the “project” wizard listed under “raster.”

As with the “define” wizard, you will be asked to specify the map layer. Next,

because you will be changing

the original layer, you are asked 

to name the new layer that

will be created. By default,  

Arcview will add “_Project” to

the original name. You may

wish to give your layer a differ-

ent name. click on the button

to the right of “Output coordinate System” to choose your projection. click on 

the “select” button on the Spatial Reference Properties, then choose “Projected 

coordinate Systems.” Now you need to choose your projection. For relatively 

small areas like Philadelphia, the differences in projection systems (the distor- 

tion in shape, area, distance, direction, and scale) are minimal. You are best off 

choosing whatever projection system is most commonly used. In Philadelphia, 

that is State Plane 1983 (feet) Pennsylvania South. For the Philadelphia MSA, 

consider UTM zone 18N. After making your selection, click “okay.” Arcview will 

indicate that there is a “Datum conflict between map and output.” In order to 

map your newly projected layer, create a new ArcMap document and add the

new (projected) layer. You should notice a change in the coordinates that show 

in the bottom right of the map.



Working with tables

Attribute Tables for Shapefiles
Every shapefile has an attribute table associated with it. You can open the table 

by right clicking on the shapefile name and going to “open attribute table.”

The table will have as many rows, or records, as it does map features. The total 

number of records will be shown at the bottom of your table. There can be any 

number of columns (fields). Two columns are standard: FID, the feature ID, and 

Shape, which can be point, polyline, or polygon. The rest of the fields will vary. In 

most cases, there will also be a column that identifies each map feature with a 

unique name, such as a census tract number or neighborhood name. There may  

be additional fields identifying attributes of the map feature (type of crime at a 

particular address, number of people living in a census tract).

Other Attribute Tables
Often you will have attribute data in a table separate from your shapefile. For 

example, you may have a census tract shapefile with no attribute information 

and a table with all of the 2000 census tract data. ArcMap can read Excel (.xls), 

dBase (.dbf), comma-delimited (.txt or .csv) and tab-delimited (.tab) text tables 

but will only allow editing for .dbf tables (you can convert .txt tables to .dbf in 

EXcEL, SPSS, AccESS, or in ArcMap). You can add attribute tables to ArcMap 

just as you do shapefiles, using the “add data” button, from the file menu, “Add 

Data.” or from catalog window. You must have the Table of contents set for 

“List by Sources” in order to see tables listed. Open these attribute tables the 

same way: right click on the name and go to “Open.”

You can work with tables—sort values, freeze columns, generate summary statis- 

tics, select records, and export tables—without worrying about messing up your 

original data the way you can in Excel if you are not careful. You cannot change 

any of the data in your table unless you go to “start editing” from the editor 

toolbar… except to add or delete fields.

Modif y ing Attributes



Sorting Records
You can sort values in an attribute table by right clicking on the field name and 

going to “sort ascending” or “sort descending.”

Freezing columns
Freeze a column (meaning that it will remain in view even as you scroll) by right 

clicking on the field name and going to “Freeze/Unfreeze column.”

Summary Statistics
You can bring up summary statistics for any numeric field (numeric fields will be 

justified right) by right clicking on the field name and choosing “Statistics.” You 

can obtain summary statistics on additional fields from the drop down menu.

Selecting Records
You can select a subset of your records to look at more closely in a number of 

different ways. You can highlight an individual record (row) by clicking in the 

gray area at the far left side of the table. To highlight multiple records, hold the 

control key down. At the bottom of the table, ArcMap will indicate how many 

of the total records are highlighted. click on the “Selected” button to view only 

the selected records. You can switch the selection, so that all of the highlighted 

records become un-highlighted and all un-highlighted records become high-  

lighted. From the options menu, choose “Switch Selection.” You can also select all 

records or clear selection from the options menu.



Exporting Tables
You may need to export your table from ArcMap, because you have made 

changes, need to convert a .txt table to .dbf, or for any other reason. with your 

table open, go to the options menu and “Export.” If you have some records high- 

lighted, you can choose to export just the selected records or all of the records.

Delete Field
You can delete a field by right clicking on its name and going to “Delete Field.” 

ArcMap will give you a warning that the deletion is permanent and not revers- 

ible. Do this with caution. changes will be permanent not just within your map 

document, but in your original file on your hard drive, as well.

Calculating values In tables

You may find it easier to edit your attribute tables outside of Arcview, but 

Arcview has fairly sophisticated tools for calculating values. In Arcview, you can 

edit values in an existing field or create a new field and calculate new values.

Keep in mind that you cannot change the format (text, integer, long integer) of 

an existing column, so if you need to transform the format of a column, you will 

need to create a new field.

creating a New Field
To create a new field, open your table in ArcMap (you can also add fields from 

Arccatalog). This can be a free-standing table or one that is associated with a 

map layer, but only .dbf tables can be edited. click on the Table Options menu 

(top left corner of the attribute table) and go to “Add Field.” If this option is 

grayed out, you do not have permission to edit the table. Most likely, this is 

because your table is in .xls format. If this is the case, export the table (an option 

within that same menu) and save it as a .dbf. Add the .dbf version back in and 

try again.

From “Add Field,” give your field a name. Do not use ?,&,$,#,@,*,!,~ or spaces 

and keep your field name to 10 or fewer characters. From the dropdown menu, 

choose the type of field. Different field types allow different types of values:

Short integer: numeric, no decimal place, up to 19 characters

Long integer: numeric, no decimal place, up to 19 characters

Float: numeric, with decimal places, (default 1 before decimal and 11 after)

Double: numeric, with decimal place (default 7 before decimal and 11 after)



calculating values Outside an Edit Session
To calculate the value of your new field (or an old field), right click on its name 

and go to “calculate values.” ArcMap will ask you if you are sure that you want 

to calculate values outside an edit session, warning that you will not be able to 

undo your results. Say “yes.”

ArcMap will bring up the Field calculator. If your value is a constant, you can 

simply type the value in the box at the bottom. More likely, your new value will 

be based on values in other fields, so you will need to use the calculator. You 

can create an expression by double clicking on the field names. For example, to

calculate the percent of the population 65 and up, click on the field name with 

the total 65 and up, click on the “/” button, and click on the field name with 

the total population. If any of the records in your table are highlighted, ArcMap 

will only perform calculations on the highlighted records. You can also calculate 

values from ArcToolbox (under “Data Management Tools”, then “calculate

Field”).

calculating values on Selected Records
You can get an error while calculating values for many different reasons. 

ArcMap will not allow you to divide by zero, so if the denominator (total 

population in example above) is zero for any of your records, ArcMap will not 

calculate any of the values.

To get around this problem, you need to select only the records where the 

denominator is something other than zero. Start by selecting the records with 

a zero in the denominator (because there are fewer of these). Do this by right 

clicking the field with your denominator and sorting ascending. Hold down the 

control key and highlight all the records with a zero. From the options menu, 

choose “Switch Selection” so that all of the records with non-zero values are 

highlighted. Now you should be able to proceed with calculating values.

calculating values Inside an Edit Session
when you need to calculate a new variable, the best approach is to calculate 

a value outside an edit session, just described. But when you need to change 

the value on just one or two values, you may want to try editing inside an edit

session. Go the Edit toolbar and, from the edit menu, choose “start editing.” You 

can only edit the contents of one directory at a time in an edit session, so you  

need to identify the directory that contains the table you wish to edit.

Open your table and double-click on the value in your table you wish to edit. 

when you are finished, go to “stop editing” in the edit toolbar and say “yes” to 

saving edits.



Calculating area, perimeter & length

calculating Area
Usually there will be a field called “area” in a shapefile when you receive it that 

indicates the area of each polygon map feature. If your shapefile is missing this 

field or if you have edited the shape and size of the map features, you will need 

to calculate area, yourself. Area can be especially helpful when you are trying 

to normalize values and create densities (calculating persons per square mile, for 

example).

create a new field called “area” and format it as a double. Right click on your 

new field and go to “calculate Geometry.” From the “Property” menu, choose 

“Area.” Note the projection and map units. You can change the units as long as 

the projection is defined (known).

You can also calculate area using ArcToolbox. “calculate Area” can be found in 

the Spatial Statistics Tools section, under “Utilities.” choose the polygon layer for 

which you want to calculate area, then determine a name and location for the 

new shapefile you will create. The new layer will be added automatically to the 

table of contents when Arcview is done calculating the area. The units will be 

what is used by the projection system for that map layer.

Creating xy coordinates

Adding XY coordinates to a Point Layer

Just as you may need to convert a table with XY data into a map layer, you 

may need to add XY coordinates to an existing layer containing points. The 

easiest way to do this is by using “Add XY coordinates” in ArcToolbox (under 

“Data Management Tools” go to “Features” to fine “Add XY coordinates”). 

Simply choose the point layer you want to assign XY coordinates and click “OK.” 

The coordinates will be in whatever units are defined by your projection (often 

feet or meters). You can also do this using the “calculate geometry” option.



Making MAPS

Symbolizing POINTS

The real strength of a GIS is in allowing you to use different symbols to represent 

different values, linking your attribute data to your spatial data. ArcMap offers 

a wide range of colors and symbols for representing your point data. Keep in 

mind that just because there are near infinite combinations that the simplest 

symbols (such as block dots) may be the most effective.

Single Symbol
The default in ArcMap is to represent all points with the same size, shape, and 

color symbol. This is how ArcMap will display your point shapefiles when they are 

first added to a map document or when you create them through geocoding or 

adding XY data. Open the layer properties (double click on the shapefile name 

or right click and go to “Properties,”) and click on the “Symbology” tab. In the 

box on the left side, “single symbol” will be highlighted. You can change the size, 

shape, or color of the symbol by clicking on it, but as long as “Single symbol” is 

selected, all of your points will appear the same.

changing the symbol
Arcview has numerous palettes of symbols used in various industries, such as 

conservation and policing. These specialized symbols are effective when used 

carefully with an audience that will recognize them as industry standards. The 

symbols included in the default palette may not be ideal for your map. For 

example, the symbol for a school bears little resemblance to a large urban 

school. To view additional pallete, click on the “style references” button. The 

“civic” palette contains a number of choices for schools. In most cases, however, 

you are better off sticking with the default symbols. You don’t need the symbol 

of a needle to represent drug crimes. Resist the temptation to make your dots

look like the real thing (such as a dead body for a homicide) These are, after all,

symbols and you will be able to describe the symbol in the legend.



Changing Map Symbols

ArcMap has many options for changing the way your data are displayed. Some 

of the simplest options involve the choice of color, fill pattern, and shape (for 

point data). To make changes, click on the map symbol in the table of contents.

The symbol selector window that opens will look different depending upon 

the type of layer: point, line, or polygon. For points, you can choose a differ- 

ent marker from the default (which is a circle with a black outline). when you 

choose a new marker, the default size jumps from 4 point (quite small) to 18

point (quite large). You can find many more symbols by clicking on “Style Refer- 

ences...” button (for example, there is a transportation, crime analysis and civic 

symbol pallette). You can change the color, size, and angle using the options

on the right of the window. The “reset” button will undo any changes you have 

made to the symbol since opening the symbol selector window.

For lines, you can choose from a variety of patterns, thicknesses, and colors. There 

are industry standards for things like highways, expressways, and railroads.

For polygons, you have choices about the fill pattern, fill color, and outline color. 

The properties button will give you additional options (and often too many 

options) but may be helpful in fine-tuning the crosshatch and ordered stipple 

patterns.

You can also symbolize your layers based on different values for each map 

feature. For example, you might use different size points to represent different 

cities around the world according to their population or use differ color markers 

to represent different types of hospitals. These are considered “thematic” maps 

and they will be discussed in the sections on displaying points, lines, and polygons.



categories
categorical variables classify data into unique categories so that each obser- 

vation (event, person, building, etc.) fits in only one category. For example, a 

hospital might be managed by a non-profit, church, federal government, state 

government, or for-profit entitity. The unique values option listed under “cate- 

gories” in the symbology tab allows you to use a different symbol for each of the 

points in a shapefile based on a categorical variable. This can work well for small 

files (10 or fewer points) but can quickly be overwhelming for larger files. choose 

the field with the values you wish to use to represent your points, then click the 

“Add All values” button in order to bring up all the categories. If you want to 

show only a few categories (for example, bus stops for a subset of routes), click 

the “Add values” button, highlight the values you want, and clik “OK.”

ArcMap will list a symbol for “<all other values>” that you can remove by taking 

away the check mark. You can change the individual symbols by clicking on 

them. You can make changes to all of the symbols, or selected symbols (hold 

down the shift key to select two or more) by right clicking. To remove a value, 

right click on it and choose “Remove value(s).” Use the black arrows on the far 

right to move values up and down (the order here will be the order your values 

appear in the legend on your map).

choose colors that communicate that these are separate categories. Don’t use a 

graduated color ramp with light to dark shades of the same color. This implies 

that one category is more or less than another when, in reality, they are just 

different. In addition to different colors, you can use different sizes and symbols... 

but don’t go too crazy.



Quantities
categorical variables correspond to categories and are generally represented 

using text variables (or numbers used as codes for individual categories). Quanti- 

ties, such as the population of a city or air emissions, are continuous and must

be presented with numbers. Graduated symbols and proportional symbols are 

the best choices to show different quantitative values for points. Graduated 

symbols allow you to have different size symbols to represent different attribute 

values. with the symbology tab active, click on “Quantities” and then “Gradu- 

ated symbols.” From the “values:” dropdown menu, select the field with the 

values you wish to use. Use the “classes” dropdown menu to change the number 

of categories. There are many ways to break up value ranges into categories.

To change the classification system, click on the “classify” button and use the

Method dropdown menu to choose a different classification system. There is no 

one “right” classification system. Your choice should be based on the distribution 

of your values and the goals of your map. In the end, you want to make sure 

that you have a map that shows variability, so you don’t want a classification 

system that groups everything together.

• Natural Breaks (Jenks): This is the default in ArcGIS. It uses a formal 

(Jenks Optimization) to minimize the variance within classes and maximize 

the variance between classes. It usually works well, but be sure to round off 

the values manually.

• Equal Interval: This sounds like a good idea because it breaks your

data into classes of equal size. The problem is, most data are not distributed 

evenly so this usually makes maps with lots of observations (map features) 

in only one or two classes.

• Quantile: This divides the observations (map features) into even groups of  

4 (quartile) or 5 (quintile). By definition, it does a good job of showing vari- 

ability.

• Standard Deviation: This shows how far values are from the mean. It 

works well when you want to show how extreme high and low values are, 

but you’ll probably want to modify the legend to show actual values and 

not standard deviations which don’t make sense to most audiences.

You can also adjust the cutoff points by moving the blue vertical lines in the his- 

togram below that show the frequency of values. Alternatively, you can change 

values manually on the previous screen by clicking on them (you will only be 

able to change the ending value).

Proportional symbols are similar to graduated symbols, but the size of the 

symbol reflects the relative size of the quantity. For example, a hospital that has 

100 beds would be represented with a symbol that is twice as large as a hospital 

with 50 beds. Proportional symbols are preferable except in situations where the 

symbols become too large and obscure other points.



Symbolizing polygons (Area DATA)

The options for symbolizing polygons (such as census tracts) are basically the 

same as the options for symbolizing points, but the attribute data that you have 

for polygons will often be different so you will utilize the same options in differ- 

ent ways.

Graduated color
You can use different colors—or different shades of the same color—to repre- 

sent different continuous variables (such as household income or median age) 

to create choropleth maps. From “Layer Properties,” click on the symbology 

tab. On the left side of the screen, click on “Quantities” and “Graduated color.” 

choose the field with the values you wish to use. Use the “classes” dropdown 

menu and the options in “classify” to change the number of categories or 

method for breaking values into categories.

choropleth maps are generally better at representing rates (such as percent 

registered voters) rather than counts (such as total voters). You can transform 

count data into rate data using the “Normalization” dropdown menu in the 

“graduate color” option. In order to use this appropriately, you will need to 

select the variable from your attribute table that serves as an appropriate 

denominator. For example, in order to show the percent of households receiv- 

ing public assistance, normalize the total number of households receiving public 

assistance by the total number of households. Do not use the “<PERcENT OF 

TOTAL>” option to create a rate (this will use a denominator based on the total 

number of map features, not a true denominator for your variable).

Graduated color works best when you use the same shade of a single color, with 

lighter shades representing lower values and darker shades representing higher 

values, or intuitive color schemes such as yellow to orange to red or yellow to  

green to blue. But keep in mind that it may be impossible to distinguish between 

more than four or five shades of the same color, depending upon the quality of 

your printer.

color ramps like these show an  

intuitive ramp from low (light) to 

high (dark). Use these to represent  

continuous values.

Diverging color ramps like these 

work well when you need to show  

above and below a mean (std).

color ramps like these don’t have  

an intuitive high or low.



You can fine tune your colors by going to “more colors” when choosing a color 

from the symbol selector. Here you can play with the hue(H), saturation(S), and 

value(v).

customizing a color ramp
You can create your own color ramp if you are not happy with any of the 

default choices. To do so, go to the “customize” menu and choose “Style 

Manager.” Expand the folder on the top left and click on the “color Ramps” 

folder Right click in the empty space on the right, choose “new,” and select Algo- 

rithmic color Ramp. Select a color for color 1 (the beginning of the color ramp), 

then a second color for color 2. Give your new color ramp a name and close the 

Type the name of the new color in the contents window. Your new color ramps 

should appear at the top of the dropdown list of color ramps in the Symbology 

tab.
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The new color ramp I created  

(above) will show at the top  

of my list of color ramps in  

the “Symbology” tab (below).

You can find a more detailed  

explanation of algorithmic, 

random, multi-part, and 

preset color ramps that can  

be created in ArcGIS in the  

help section.

Fill Patterns
You can use different patterns in addition to, or instead of, using different colors 

to represent different values. Patterns are particularly helpful when you are 

restricted to printing maps in black and white. choose “Graduated colors” from 

the Symbology tab and select the field with the values you want to display. Set 

the number of classes and the method of classification, so that you are happy 

with the value ranges. Then click on the symbols and change the fill using the 

symbol selector. click on the Properties button to fine-tune the fill pattern. This 

may involve changing the background from white to “No color” so you can 

draw a layer symbolized with a fill pattern on top of a layer with solid colors in 

order to see the relationship between two different attributes.



Dot Density
Dot density maps use randomly placed dots within polygons to represent dif- 

ferent values for aggregate data. They provide an alternative to choropleth 

maps for count data. If you use this option, be sure to remember—and carefully 

communicate on your map—that the points do not represent precise locations, 

as they do in a point layer. Failing to do so may generate confusion and concern 

about data confidentiality. One major limitation of this type of map is that the 

dots may be distributed across parts of the polygon that don’t make sense. For 

example, if you use dot density to show the number of foreign-born in a map

of counties, the dots might appear in non-residential areas. You can avoid this 

problem by selecting a “mask” (such as parks and industrial areas) where dots 

should not be placed.

To create a dot density map, open the Layer Properties and make the Symbol- 

ogy tab active. click on “Quantities” and “dot density.” From “Field Selection,” 

choose the field you wish to use as the basis for the map. counts (such as the 

total number of households on public assistance) are appropriate for dot density 

maps, but averages, medians, and rates are not. choose your dot size, or keep 

the default (which is advisable, at least to start). The “Min,” “Mean,” and “Max” 

boxes will give you a preview of how your map will look. The “Dot value” 

indicates how many units each dot represents. change this as needed to create 

dot densities that have enough dots to show variation but not so many that they 

are all on top of each other. You can change the color of the dot by clicking on it 

under “Symbol” in the top right part of the screen. checking “maintain density” 

will ensure that the dot density looks the same as you zoom in and out (by 

making the dots bigger and smaller).



Pie charts
charts are good for showing multiple values and the relationship between 

values on different variables. Pie charts are especially good for showing propor- 

tions. For example, individual pie pieces can be used to show the breakdown in 

race for the population in a census tract. For the pies to work, you must be able 

to put every person into a racial group, or you must use an “other” category.

Pies contain a lot of information, so it can be difficult to display them clearly. To 

create pie charts, click on “charts” and “Pie” from the Symbology tab. Holding 

down the shift key, select the fields that you want to include. Make sure that 

together, they add up to 100 percent (you may need to create and calculate

a new “other” field in your attribute table before using charts). click on the 

“Background” button to change the color or fill (“Hollow” or white backgrounds 

might be best, so that you don’t have too many colors in your map). If you check 

“Prevent chart Overlap,” Arcview will use “leader lines” to indicate where the 

pie charts belong if there is no room to display them within the map feature. 

click on the Properties button to make adjustments to the look of the pie (3D, 

rotation, height).

click on the Size button if you want to have different size pie charts depend- 

ing upon the total (such as total population). If you choose to “vary size using 

a field,” you may need to exclude records with a zero value. To do this, click on

the Exclusion button and, using the appropriate field name, create an expression 

such as “[TotalPop] = 0.” You may need to play with the minimum size on the 

previous screen to make the maximum size pie chart a reasonable size.



Bar/column charts
Bar charts can be used to compare values on two or more variables that do not 

represent proportions (they don’t have to be subsets that add to 100 percent). 

For example, the map on the right compares the total population by block 

group to the total number of households. To switch from column (vertical) to bar 

(horizontal) charts, go to Properties on the Symbology tab of Layer Properties 

and switch the radio button under “Orientation.”

Stacked charts
Stacked charts can be used to compare values on two or more variables (such as 

race) that are subsets of a larger variable (such as total population) when you 

don’t know, or don’t want to display, all of the subsets. You have many of the 

same options for formatting (size, color) that you have with the other types of 

charts.

LABeLINg feATUReS

Labeling features can be frustrating and tedious, but labeling features well is 

important to making your maps readable and communicating their meaning, 

so it’s worth the effort to learn.

Using Text Boxes to Label Features
You can place text on a map in order to label map features. The text tools 

require that you type the feature name yourself while the label tools take ad- 

vantage of feature names stored in the attribute table. The text tool can work 

well if you only have a few map features to label.

click on the large letter “A” on the drawing 

toolbar. This will bring up seven different  

text and label options. click on the “A.” click  

on your map where you want your text to 

appear and type your label in the text box. 

Hit the enter key, or click your cursor outside  

the text box to complete. You can move

the text around using the “Select Elements”  

tool. Double clicking on the text will bring up  

the Properties, where you can change the  

size and font (using the “change Symbol” 

button).

The callout text tool works similarly, except that it allows you to place your 

text away from the map feature while still indicating what is being labeled. click 

on the tool and then click on your map feature. Before letting go, you can move



the cursor to where you would like the label to be. Type your label. Using the 

“Select Items” tool, you can move the text box so that it is closer or further from 

the map feature. The yellow background with black text may not be what you 

want (actually, it probably won’t be what you want).

From the “text properties” dialogue box, choose “change symbol,” then 

“properties,” then the “advanced text” tab, then the “properties” button below 

“text background”. From here, you can choose between two different style 

callouts. click on the “symbol” button to change the background color.

A third option is the spline text tool. This allows you to write text along a 

curved line. This works well for labeling rivers and curvy roads. click on the spline 

tool, then click on the starting point for your label. continue to click along the 

curve (you don’t need to make many clicks) and double click to finish. Then 

type your label in the text box. You will probably need to try this several times 

to get a label with which you are happy (just click on the label with the “Select 

Elements” tool and hit the “delete” key to delete a label).



Manually Placing Labels
Using the label tools in ArcMap, rather than the text tools, allows you to use the 

values in a layer’s attribute table for your labels (in other words, you don’t have 

to type the label out as you do with the text tools). By manually placing labels, 

you also avoid having your labels act as a group (which happens with auto 

labeling), so it’s easier to move or edit a single label.

Before you can use the label tools in ArcMap, you need to indicate which field 

in the attribute table of your map layer you want to use as the basis for labels. 

From Layer Properties, click on the “Labels” tab. Leave the “label features in 

this layer” box empty (clicking this creates auto labels). choose the appropriate 

field from the Label Field dropdown menu. click on symbol to change the size, 

style, or font for your labels. (Guessing what size to make your labels is diffi- 

cult and you will probably need to make small adjustments after seeing what

works). Using the “Placement Properties” button, you can instruct Arcview what 

to do about duplicate labels. The “Scale Range” allows you to instruct Arcview 

when to draw or not draw labels, depending on the extent. In order to do this, 

you need to know the exact scales you’ll be using (so you probably just want to 

leave this alone). The “Label Styles” button gives you access to some fancier label 

options. The highway labels are particularly helpful. Now you can use the label 

tool to manually label your map features.

close the “Layer Properties” dialog box.  

click on the button marked “A” on the  

drawing toolbar and choose the “Label”  

tool. The “Labeling Options” window  

will open. Decide if you want Arcv iew   

to decide the best label position or if you  

want to determine that yourself. The  

“choose a style” radio button gives you  

access to those fancier labels again. You  

can move these labels (using the “Select  

Elements” tool which is the black arrow)  

and change their size and style (double 

click to bring up Properties). You can

delete a label by clicking on it and pressing 

the “Delete key” on the keyboard. To 

delete all labels, from the Edit menu 

choose “Select all elements” and click the  

“Delete” key.



Auto Labeling
You may find it easier to automatically label all of your features. This saves time 

if you are happy with the way the labels look, but it offers you much less control 

over the label placement. when you automatically label features, the labels

are “dynamic” so changes you make to one (moving it, changing the style) are 

made to all. To label your map features automatically, go to Layer Proper- 

ties, click on the Label tab, and put a check mark in the “Label Features in this 

layer” box. You can also label automatically by right clicking a map layer and 

going to “Label Features.” To delete your labels, you’ll need to return to the 

Label Properties box and remove the check mark from “Label Features in this 

layer” box or right click and go to “Label Features.” You can select “In the map” 

as a place to store the annotation.

converting Labels to Annotation
One solution to the problem that auto labeling presents with groups of labels is

to convert them to annota- 

tion. This allows them to  

function as individual text  

boxes so you can change the  

style for a single label. To do  

this, right click on your map  

layer after labeling it and go 

to “convert Labels to An-  

notation.”

Using a Halo with Labels
Sometimes labels are difficult to see on top of a map that includes many differ- 

ent shades and colors. By creating a halo around the label, it will stand out. To 

create a halo, double-click on the label text to bring up the “Properties” dialog 

box, then click “change symbol,” “properties,” and select the “mask” tab. choose 

the “halo” radio button. You can select a halo color other than white and adjust 

the thickness (1.5 point may be enough).



Designing MAP layouts

Displaying data so that you can analyze spatial patterns on a computer screen 

is one thing; printing out a map for other people to look at is quite another.

ArcMap thinks of these as distinct functions and makes available a series of tools 

for designing map layouts that you don’t need until you are ready to print.

Layout view
when you open ArcMap, you are in “Data view” and use the Tools toolbar to 

navigate your map. when you switch to the Layout view, you have access to 

a different range of tools and use the Layout toolbar to navigate. To switch to 

“Layout view,” click on the icon at the bottom of your map display that looks 

like a piece of paper (next to the globe icon) or, from the view menu, go to 

Layout view.

To make your map larger or smaller  

on the page, you can use the zoom  

tools on the Tools toolbar or on the  

Layout toolbar. The Layout toolbar  

also includes a pan tool that you  

can use to move your whole layout.  

To move just your map (and not  

the whole page), use the pan tool

in the Tools toolbar. The fixed zoom  

tools in the Layout toolbar work  

like the ones on the Tools toolbar.  

The “Zoom to whole page” button is  

especially useful.

One of the biggest differences in Layout view is that many more options in the 

“Insert” menu become active. These options allow you to add elements—includ- 

ing a title, legend, north arrow, scale bar, and image—to your layout. Each of 

these will be separate objects in your layout that can be moved and resized 

through their Properties. You won’t see any of them if you switch back to Data 

view since they are meant to clarify printed maps, not help you interpret your 

map on screen (in fact, the layout view is probably more confusing to look at 

from the screen because it adds so many elements and usually shrinks your 

map). You can add text in the Layout view, but you are better off trying to 

label features from the Data view, using the label or text tools.

In Layout view, you get a much better idea of how your map will look when 

it’s printed. ArcMap will automatically place a border (“neat line”) around your 

map. You can remove this by right clicking on the border (so the line is turquoise 

and perforated) and going to “Properties.” click on the “Frame” tab. From here 

you can choose a different style or color frame (to get rid of it altogether, choose 

“no color” from the color selector). You can also change the background color 

and add a shadow (to add a shadow, you’ll need to change the X and Y offset 

to something other than 0).



w orking with Grids and Rulers
You can bring up a number of options aimed  

at helping you to place the objects within your 

layout by right clicking in your layout outside 

of the neat lines. From “Options,” you can  

specify ruler units and turn on and off rulers  

and grids when the “Layout Options” tab is  

highlighted. choosing to “snap” to the grid or 

rulers will help you to line up objects, but it  

will also limit your ability to make fine-level 

adjustments.

Adding a Title
To add a title, from the Insert menu go to  

“Title.” Type your title in the text box and hit 

the enter key or click the cursor outside the  

text box. Double click on the title to bring up

the Properties where you can make changes to the text and formatting.

Adding a Legend
Unless your labels are able to fully explain your map features, you will want a 

legend on your layout. ArcMap gives you great flexibility in formatting your 

legend, and all the choices can be overwhelming. To add a legend, from the 

Insert menu go to “Legend.” Your first choice is what map layers you want 

included. Arcview will guess that you want to include all active layers. This may 

not be the case if you have layers such as a county boundary, rivers, or other 

obvious features that don’t need to be included in the legend. To remove a layer 

from the legend, click on its name on the right side of this first screen and click

on the “<” button. The order your layers are listed under “Legend Items” will cor- 

respond to the order in which they appear in your legend. To change the order, 

click on the name and hit the up or down arrows (don’t worry; this won’t affect 

the order in which they are drawn).

If you want more than one column in your legend, make the adjustment here.

To see what your legend will look like (before working your way through 

the rest of the screens), click the “Preview” button. If you are satisfied with it, 

you can click the Finish button and skip the other steps. Otherwise, click the

“Preview” button again and click “Next.” On the second screen of the Legend



wizard, you can give your legend a title or leave the word “Legend” as the 

title (or just leave it blank). The third screen allows you to create a frame and 

shadow around your legend (not necessary, but depending upon your layout it 

may be helpful, particularly if you gave your layout a background color). On

the fourth screen, you can change the symbols and symbol size used to represent 

lines and polygons in your layout. On the final screen, you can make adjustments 

to the spacing between items in your legend. click “Finish.” To make changes 

after you have created your legend, double click on it to bring up Properties.

cleaning up your map legend
chances are that you’ll need to clean up your legend at this point. Some of your 

map layer names may have underscores or other cryptic notations. The legend 

will use the same names that appear in the table of contents. You can change 

the label names in the table of contents without changing the name of the 

shapefiles on your computer. From the table of contents, click once on the map 

layer name, then click again (but not quickly). The label name should become

highlighted, allowing you to make changes. You can also change the map label 

names from the “Layer Properties” dialog box, from the “General” tab.

You may also need to translate some of the values that appear in your legend. 

For example, you may choose to symbolize a parcel shapefile with two different 

colors for the codes “1000” and “9999” which represent streets and sidewalks, 

respectively. From the “Symbology” tab, type in “street” and “sidewalk” under 

the Labels. Be careful not to change the numbers listed under “value” because 

this will change your map.

For maps symbolized using graduate  

colors, you may also want to make ad- 

justments using the “Label” section. For  

income, be sure to add $ and commas.  

For percentages, click on the word  

“Label” in the “Symbology” tab, choose 

“format labels” and select “percentage.”  

If your number looks like a decimal (0.15  

for 15%), choose the second radio button 

and click on “Numeric option.” Here you  

can change the number of decimals (in  

most cases, choose 0 or 1).



Adding a Scale Bar
To add a scale bar, you must  

identify the appropriate units 

for your map. You can set these  

from the Data view or Layout 

view. From Layout view, right 

click in the layout (anywhere 

inside the neat lines), go to  

Properties, and make the 

General tab active. From the  

map units dropdown menu, 

choose the units used for the  

original map projection (see 

“working with Projections”).

Adding Scale Text
You may wish to include a text description of the map scale, particularly if this 

is important to your audience and you deliberately chose a scale (as opposed to 

maximizing the size of your map based on the size of your page). To add scale 

text, from the Insert menu go to “Scale Text.” Double click on the scale text in 

your layout to bring up the Properties, where you can make changes to the 

format and units.

Once this is set, you can  

choose any display units you  

want. To add your scale bar,  

from the Insert menu, go to  

“Scale bar.” click on a style  

and hit “OK.” Your scale bar  

should appear on your map.  

You can move or resize it by  

clicking on it. Double click

to bring up the Properties, 

where you can change the  

number of divisions and   

as well as the font size (by

clicking the Symbol button  

or from the format tab). You 

can also change the division  

units, from feet to miles or

km, here. If your units read “unknown units,” you will need to define your map 

projection before proceeding.

YesNo

Adding a North Arrow
You may decide that a north arrow is not necessary (unless you choose to rotate 

your map so that north is no longer towards the top of the page; in that case, it 

is definitely necessary). If you do wish to add a north arrow, from the Insert menu 

go to “North Arrow.” choose a style from the “North Arrow Selector” (prefer-

ably something simple, and small).

You can move it around on your  

layout by clicking on it. Double 

click to change the size or style.  

consider a small north arrow and

one that is discreet.



MULTIPLe-MAP LAyOUTS

You may need to create a printed map that includes more than one map, either 

because you can’t fit everything (such as Alaska and Hawaii) on your main 

map, you want to show a series of small multiples (same map with different 

variables), or because you want to zoom into a small area for your main map 

and indicate on a smaller overview map what area the larger map covers.

Adding Group Layers
Most of the time you will only need one data  

frame in a map document. working with 

data frames can make your map document  

complicated and prone to crash. But if you  

need to include more than one map in your  

layout (including the same map at a different 

extent), you’ll need two or more data frames. 

w hen you open ArcMap, you’ll just have

one data frame (called “Layer”) and every  

map layer you add to your map document 

becomes part of this frame. To create a second 

data frame, from the Insert Menu go to “Add 

Group Layer.”

To add new data to a particular data frame,  

right click on its name and go to “Add Data” 

or highlight its name and use the Add Data

button (or, from the Insert menu, go to “Add Data”). If you want to move a 

layer to a different data frame once it is in ArcMap, right click on it and go

Rotating a Map
You can rotate your map to better fit the page or to make it easier to read (just 

because you can do this doesn’t mean it’s a good idea). If you do this, make sure 

that you have a north arrow on your map. As you rotate your map, your north 

arrow will adjust to indicate which direction is north. From the view menu, go

to Toolbars (or just right click on a gray part of the GUI) and Data Frame Tools. 

click on the “Rotate Data Frame” button, then click and hold down on your 

map, moving your map to change the rotation. To restore the original orienta- 

tion, click on the “clear Rotation” button.



creating Inset Maps
If you want to have an overview map that shows on a larger map the outline of 

the area your detailed map includes, you’ll need to create an extent rectangle. 

To do this, follow the instructions above to create two map layers: a detail layer 

and an overview layer.

Zoom in on your detail layer in the map view and resize it in the layout view so 

that it looks the way you want. Then right click on the overview layer in your 

table of contents. From “Properties” click on the “Extent Rectangle” tab. Move 

your detail layer from the left to the right side. click on the “Frame” button to 

make changes to the outline of your box.

to “copy.” Then right click on the name of the data frame where you want 

to move it and go to “Paste Layer.” The layers in only one data frame can be

displayed in the map view at a given time. It does not matter which one is listed 

first in the table of contents; it matters which one is active. To display the layers 

in a data frame, right click on its name and go to “Activate.” when you switch 

to the layout view, you will see that there are two map images, one for each 

data frame. You will likely need to resize and move these to fit together.



Exporting MAPS Inserting Maps into Power Point
Save your map as an .jpg. with Power Point open, go to the Insert menu, 

“Picture,” and “from file,” then Navigate to you map image and click “Insert.” 

You may notice that there is a lot of white space around your map. Eliminate 

this using the crop tool. You must have the map image active (click on it so that 

you see small squares at the corners). click on the crop tool and crop the image 

by clicking on one of the small boxes and dragging the cursor (if you do this 

without having the crop tool active, you will shrink the whole image).

You are probably better off creating map titles in Power Point rather than 

Arcview. Also, if you are making a map specifically for Power Point, consider 

making the legend larger than usual (14 points or more) so that your audience 

can read it.

Inserting Maps into Microsoft word
Follow the same procedures for inserting a map into Microsoft word. You may 

have less flexibility in moving the map around than in PowerPoint, but you 

should be able to crop and resize it.

If you just need paper copies of your maps, you will probably have the best 

results printing them from Arcview. But if you need to insert maps into Power 

Point or word processing files, will need to export your maps.

Exporting Process
You can export a map from ArcMap when you are in Data view or Layout 

view. However, if you want your exported map to include titles, legends, scale 

bars, north arrows, and anything else you added to the layout, you’ll want to 

export from Layout view. From the File menu, go to “Export Map.” There are 

many options for export formats in the “Save as type” drop downmenu.

.PDF: The .pdf format allows you to open the map directly (without inserting 

it into PowerPoint or MS word) as long as you have Acrobat Reader. This is 

probably the best option if you need to send someone a map or post a map on 

the Internet.

.JPG: The .jpg format will compromise the quality of your image, so be sure to 

click on the “options’ button when you export and increase the resolution to at 

least 200 dpi (300 dpi will be as good as you need for most things). The .jpg 

format is good because it stores your map in a fairly small file.

.TIF and .EPS: The .tif and .eps formats work well if you are going to open your 

maps in a graphics software package, but they result in larger files.

Screen Capture: If all else fails, you can take a screen capture (push the print 

screen button or alt + print screen buttons, then choose “paste”) and crop the 

image, but this will not result in a presentation-quality map.



In order to start georectify- 

ing, you’ll need to switch  

back so that you can see  

your shapefile, rather than  

your image. Right click on 

the shapefile and choose  

“zoom to layer.” From the 

view menu, choose toolbars,  

then Georeferencing.

Georectifying images

Georefectifying allows you to convert a paper map into a GIS map layer. Es- 

sentially, the process assigns X and Y coordinates to points on your digital map 

image, shifting, rotating, and scaling your map so that you can view it as a map 

layer along with your shapefiles. The simplest form of this, using onscreen tools, is 

explained below. This is especially value for incorporating historical maps to GIS.

create a raster image

Scan your paper map. The higher resolution, the better. ArcMap can handle 

pretty big files, and it can work with lots of file types (.jpg, .tif, .bmp). If you have 

a choice, go with .tif and 300 dpi or better.

Add reference layers (shapefiles)

Before you add your scanned image, add a shapefile that covers the same geo- 

graphic area. This might be a street centerline file, city boundaries, or something 

similar. Be sure that you can identify a few places on your scanned maps on this 

shapefile (such as a landmark or street intersection). Otherwise, you will not be  

able to use on-screen georectifying.

Add map image
Add your image to ArcMap just as you would a shapefile or table, using the 

button or from the file menu, choose “add layer.” Depending upon the size of 

your image, a dialogue box will ask you if you’d like to add pyramids. click 

“OK.” Don’t worry if you get a warning message that your image lacks projec- 

tion information. At this point, your scanned map is just an image, so it shouldn’t 

contain any spatial information. The name of your image should now appear in 

the table of contents, but you will not see your image drawn with your shapefile

SPATIAL DATA

because it is in “pixel space” since there is no coordinate information. To see your 

image, right click on the name and choose “zoom to layer.”



From the georeferencing menu, choose “fit to display.” Now your reference 

layer(s) should draw on top of your map image in the view map window. If your 

scanned map is upside down, use the “Flip or Rotate” tools.

Add control points
click the “add control points” button. create your first control point on your 

image by clicking once on your scanned map, then click on the shapefile in the 

corresponding spot. Your image should shift closer to your shapefile. If it gets 

further away, you probably reversed the order. Be sure to click on your scanned 

map first, then the shapefile. You may find it helpful to use the magnifier 

window (from the window menu, choose “magnifier”) so that you can see your 

map details without zooming in. continue to add control points. After doing 

this a few times, your image should be more or less lined up with your shapefile. 

continue to add control points as long as doing so improves the alignment.



In most situations, your map image will not line up perfectly with the shape- 

file and you should not expect it to. The original map you scanned may have 

been created using a different projection system or included distortions and the 

map may have been further distorted or damaged over time. If the image gets 

further and further away from the shapefile, however, try starting over. From  

the georeferencing menu on the georeferencing toolbar, go to “delete control 

points” and “reset transformation,” then choose “fit to display” again. You can

also delete a single control point using the “view links” button. The control points 

are listed in the order that you created them, so the most recent control point 

will be listed last. To delete one, hightlight it and click the delete (X) button.

You may find it easier to line up the scanned map and reference shapefile using 

the magnifier tool. From the windows menu, choose “Magnifier.” Move the Mag- 

nifier window over your maps in areas where you are having trouble lining them 

up. You can add control points from inside the Magnifer window.

Transformations
If you have six or more control points, you can perform a second order; if you 

have twelve or more control points, you can perform a third order transforma- 

tion. But be sure to look at how these transformations distort your map. You 

may be better off with the first-order transformation.

Saving the Georeferenced Image

In order to permanently save the transformation, choose “Update Georefer- 

encing.” This will add the spatial information directly to your scanned map 

(meaning you will loose the original version). If you choose “rectify” from the 

georeferencing menu, ArcMap will create a new image with the spatial data. 

Note that the new rectified map may be very large and may look slightly differ- 

ent (darker, poorer resolution).
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